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Chapter 1: Introduction
This document provides information about using and developing for the 
Telnet Client Industrial Browser. 

This section provides the following information:

• Document Assumptions

• Document Conventions

• About the Telnet Client Industrial Browser

Document Assumptions

This document assumes that the reader has the following:

• Knowledge of wireless networks and wireless networking protocols.

• Knowledge of TCP/IP, including IP addressing, subnet masks, routing, 
BootP/DHCP, WINS, and DNS.

• Knowledge of Wavelink Telnet Client.

• Knowledge of web page development, including implementation of 
META tags and IDA commands.
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Document Conventions

The following table lists the document conventions used in this manual.

About the Telnet Client Industrial Browser

Wavelink Telnet Client includes an Industrial Browser interface that gives you 
the ability to access web-based applications from a mobile device. The 

Courier New Any time you type specific information into a text 
box (such as a file name), that option appears in the 
Courier New text style. This text style is also used 
for any keyboard commands that you might need to 
press.

Examples:

Type Enter to continue.

Press CTRL+ALT+DELETE.

Bold Any time you interact with an option (such as a 
button or descriptions of different options in a dialog 
box), that option appears in the Bold text style.

Examples:

Click Open from the File Menu.

Select the Update option.

Italics Any time this document refers to another section 
within the document, that section appears in the 
Italics text style. This style is also used to refer to the 
titles of dialog boxes.

Examples:

See Configuring WEB Emulation Parameters on 
page 14 for more information.

The Script Editor dialog box appears.
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Industrial Browser supports PocketPC 2003, Windows Mobile 5.0, Windows 
2000/XP, and Windows CE .NET 4.2/5.0.

NOTE The Industrial Browser is included in Telnet Client 6.0 and later 
versions.

Licensing

The Telnet Client Industrial Browser requires a license for full functionality. 
You can use the Telnet Client Industrial Browser without a license, but you 
will be limited to the demo version, which does not provide full Telnet Client 
functionality.

Licenses for the Industrial Browser are separate from other Terminal 
Emulation Client licenses. To obtain Telnet Client licenses, please contact 
Wavelink Customer Service. Appendix A: Wavelink Contact Information on 
page 41 provides Wavelink contact information.
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Chapter 2: Configuring Host Profile and 
Emulation Parameters

This chapter provides information about the following:

• Configuring the Industrial Browser Host Profile

• Configuring WEB Emulation Parameters

Configuring the Industrial Browser Host Profile

Before you can use the Industrial Browser, you must create a Host Profile for 
WEB emulation. A Host Profile defines the parameters that the Telnet Client 
should use when it attempts to initiate a Telnet connection with a specific 
host. 

You may configure as many WEB emulation Host Profiles for the Telnet 
Client as you wish.

NOTE For more information about creating Host Profiles, refer to the Telnet 
Client User Guide.

To create a Host Profile:

1 Access the Edit Host Profiles dialog box.

2 From the Type drop-down menu, select WEB.

3 Enter the host Name and Address in the appropriate text boxes and click 
OK.

NOTE You may enter a subnet-specific address rather than an IP address or a 
DNS name. For more information, refer to Wavelink Telnet Client User Guide.

The WEB emulation Host Profile is created.
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When you configure the Host Profile for WEB-type emulation, various tabs 
appear offering different options for WEB settings.

Figure 2-1. Configuring WEB Settings

The following sections describe the parameters of each tab used to configure 
WEB emulation settings in the Host Profiles dialog box.

HTTP Proxy Tab

Use the HTTP Proxy tab to configure proxy connections for WEB emulation.
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Figure 2-2. Configuring the HTTP Proxy Tab

The following list describes the options and configurable parameters in the 
HTTP Proxy tab.

Connection Type Indicates the type of connection for the Host Profile 
to use.

Possible Values: <Direct Connection> <Use Explorer 
Default> <Use Proxy Server>

Default Value: <Direct Connection>

Proxy Server Indicates the location of the proxy server.

Possible Values: Any valid IP address, host name, or 
web address.

Default Value: <None>
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HTTPS Proxy Tab

Use the HTTPS Proxy tab to configure secure proxy connections for WEB 
emulation.

Figure 2-3. Configuring the HTTPS Proxy Tab

Port Indicates the network port for the proxy server.

Possible Values: Any valid port number.

Default Value: <8080>

Do not use the proxy 
server when contacting 
local hosts

Indicates whether the Telnet Client should use the 
proxy server when contacting hosts that reside on 
the same network. 

Possible Values: <Enabled> <Disabled>

Default Value: <Disabled>
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The following list describes the options and configurable parameters in the 
HTTPS Proxy tab.

Access List Tab

Use the Access List tab to configure which web addresses can be accessed by 
the Telnet Client Industrial Browser.

Connection Type Indicates the type of connection for the Host Profile 
to use.

Possible Values: <Direct Connection> <Use Explorer 
Default> <Use Proxy Server>

Default Value: <Direct Connection>

Proxy Server Indicates the location of the proxy server

Possible Values: Any valid IP address, host name, or 
web address.

Default Value: <None>

Port Indicates the network port for the proxy server.

Possible Values: Any valid port number.

Default Value: <8080>

Do not use the proxy 
server when contacting 
local hosts

Indicates whether the Telnet Client should use the 
proxy server when contacting hosts that reside on 
the same network. 

Possible Values: <Enabled> <Disabled>

Default Value: <Disabled>
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Figure 2-4. Configuring the Access List Tab

The following list describes the options and configurable parameters in the 
Access List tab.

Allowed Web Server 
Addresses

Lists the web addresses that the Telnet Client is 
permitted to connect with.

Possible Values: Any valid IP address, host name, or 
web address.

Default Value: <None>

Allow web servers on 
the local network 
(subnet)

Indicates whether the Telnet Client can connect with 
any web server or only with severs on the local 
network.

Possible Values: <Enabled> <Disabled>

Default Value: <Disabled>
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Configuration Tab

Use the Configuration tab to modify emulation parameters for the Host 
Profile.

Figure 2-5. Configuration Tab

Select Modify to access the Configuration Manager or Reset to restore default 
settings.

NOTE For more information about emulation parameters, refer to  Configuring 
WEB Emulation Parameters on page 14.

Add Address Select this button to add a new IP or web address to 
the list of addresses that Telnet Client is permitted to 
connect with.

Delete Address Select this button to delete any address in the list.
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Configuring WEB Emulation Parameters

You can manually configure certain Telnet Client emulation parameters on a 
per-host basis.

NOTE For more information on configuring Emulation Parameters, see the 
Telnet Client User’s Guide.

You can configure parameters for WEB emulation from the WEB tab in the 
Settings dialog box. You can also configure parameters by accessing the 
Configuration Manager from the Configuration tab in the Host Profile.

The following table describes the configurable options in the WEB tab.

WEB Allow 
Compression

Determines whether the browser will automatically 
decompress any compressed information it receives.

Possible Values: <Yes> <No>

Default: <Yes>

WEB Allow Cookies Indicates whether the web server is able to access 
cookies on the client.

Possible Values: <Yes> <No>

Default: <Yes>

WEB Automatic SIP Determines whether the SIP keyboard is 
automatically displayed when the cursor is moved to 
an edit field.

Possible Values: <Enabled> <Disabled>

Default: <Disabled>

WEB Default Scanner 
Auto Keys

Determines the default post-scan action for web 
pages without Tab or Enter key META tags 

Possible Values: <No Keys> <Enter> <Tab> <Enter 
and Tab>

Default: <No Keys>
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WEB Default Text Size Indicates whether the default text size should be 
used when the browser first appears. 

Possible Values: <Smallest> <Smaller> <Medium> 
<Larger> <Largest> <No Change>

Default: <No Change>

WEB Detect Out-Of-
Range

Indicates whether Telnet will prevent the user from 
interacting with a web page if the Wireless LAN 
adapter is not associated with an access point. 

Possible Values: <Enabled> <Disabled>

Default: <Enabled>

WEB Display Images Determines if embedded images and/or placeholders 
should be displayed on web pages.

Possible Values: <Enabled> <Disabled>

Default: <Enabled>

WEB Engine Type Indicates the type of web engine that should be used. 
The Enhanced engine is required to support several 
advanced features.

Possible Values: <Standard> <Enhanced>

Default: <Enhanced>

WEB Error 404 
Override

Determines whether a custom or standard 404 error 
message is displayed.

Possible Values: <Display Standard 404 Error 
Messages> <Custom Message>

Default: <Display Standard 404 Error Messages>
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WEB Error Messages Determines whether server error messages relayed 
from the server are displayed.

Possible Values: <Server Error Messages> <Local 
Error Messages>

Default: <Server Error Message>

WEB Error No 
Connection Override

Determines whether a custom or standard error 
message is displayed when WEB Emulation is 
unable to connect to a server.

Possible Values: <Display Standard No Connection 
Messages> <Custom Message>

Default: <Display Standard No Connection 
Messages>

WEB Fast Keyboard 
Support

Indicates whether an alternate method to pass 
keypresses to WEB Emulation is used.

Possible Values: <Enabled> <Disabled>

Default: <Disabled>

WEB HTTP Version for 
Direct Connections

Determines if the HTTP 1.0 or HTTP 1.1 protocol 
should be used for direct (non-proxy) connections.

Possible Values: <HTTP 1.0> <HTTP 1.1>

Default: <HTTP 1.1>

WEB HTTP Version for 
Proxy Connections

Determines if the HTTP 1.0 or HTTP 1.1 protocol 
should be used through proxy connections.

Possible Values: <HTTP 1.0> <HTTP 1.1>

Default: <HTTP 1.0>

WEB Out-Of-Range 
Message

Allows you to customize the out-of-range message 
that is displayed on the mobile device.

Possible Values: <Any>

Default Message: <Network Out Of Range>
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WEB Play Background 
Sounds

Determines whether sounds embedded in the web 
page will be played.

Possible Values: <No> <Yes>

Default: <Yes>

NOTE Sounds will only be played if supported by the 
mobile device sound card.

WEB SAP Keyboard 
Support

Indicates whether functions on SAPWebConsole 
pages can be activated by the keyboard.

Possible Values: <Enabled> <Disabled> <Auto-
Detect>

Default: <Auto-Detect>

WEB Scan Data 
Insertion Method

Determines the method used to feed scan data to a 
web page.

Possible Values: <All At Once> <Keyboard Data>

Default: <All At Once>

WEB Show Progress 
Bar

Indicates whether the browser should display a 
progress bar during a web download.

Possible Values: <Yes> <No>

Default: <Yes>
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WEB Underline Links Determines if links (anchors) on the web page will be 
underlined.

Possible Values: <No> <Yes>

Default: <Yes>

NOTE This is not supported on Pocket PC and 
Windows Mobile devices.

WEB User Agent Specifies the value that is included with the HTTP 
header information sent by the device to the web 
server.

Possible Values: Any valid User Agent value.

Default: <The value that Internet Explorer or Pocket 
Internet Explorer would use on the device>
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Chapter 3: Using the Industrial Browser
This chapter provides information about using the Telnet Client Industrial 
Browser, including the following:

• Basic Navigation 

• Specifying the Home Page 

• Using the WEB Virtual Emulation Keyboard 

Basic Navigation

The Telnet Client Industrial Browser interface provides basic commands for 
navigating web pages.

To navigate within the Industrial Browser:

1 Connect to a WEB emulation session.

2 Tap and hold on the screen.

A menu appears.

3 From this menu, you can select from the following options:

Back Returns the browser to the previous web page.

Forward Returns to the screen displayed before Back was 
selected.

Stop Stops the web page from loading.

Refresh Reloads the current web page.
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Specifying the Home Page

The home page is the first page users will see when connecting to the 
Industrial Browser; it is also the page users will be returned to when they 
select Home. The home page will be the location you set up in the Host 
Profile for WEB emulation. This can either be an IP address or a specific web 
address. Refer to  Configuring the Industrial Browser Host Profile on page 7 for 
more information.

Using the WEB Virtual Emulation Keyboard

The Telnet Client Industrial Browser contains a default emulation keyboard. 
You can access the keyboard through the Telnet Client Options menu. 

Figure 3-1 shows the Telnet Client virtual emulation keyboard for WEB 
emulation.

Figure 3-1. Telnet Client WEB Virtual Emulation Keyboard

Home Returns the browser to the specified home page.

Text Size Displays a menu with the following text size options:

• Largest

• Larger

• Medium

• Smaller

• Smallest
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The following list describes the function of the keys in the WEB virtual 
emulation keyboard.

Back Returns the browser to the previous web page.

Fwd Returns to the screen displayed before Back was 
selected.

Stop Stops the web page from loading.

Refresh Reloads the current web page.

Home Returns the browser to the specified home page.

Prev Sess Cycles to the previous Telnet Client session.

Next Sess Cycles to the next Telnet Client session.

Close Disconnects the session. (Only available when the 
session is connected.)

Key Clicks Turns key clicks on/off

Quiet Turns quiet mode on/off.

Info Shows/hides the following information about the 
mobile device:

• Telnet Client version information

• MAC address

• IP address

• ESSID

Diags Allows you to access the Telnet Client diagnostic 
tools.



22 Wavelink Telnet Client Industrial Browser Reference Guide
Alpha Displays the alpha keys for WEB emulation, 
including:

• a-z

• Shift, Ctl, Alt

• Esc, Tab, Caps, Enter, Space

Num Displays the numeric keyboard for WEB emulation, 
including:

• 0-9

• Shft

• Esc, Tab, Ins, Enter, Space

Func Displays the function keys for WEB emulation, 
including:

• F1-F24

Punc Displays the punctuation keys for WEB emulation, 
including:

• Punctuation keys

• Enter, Space

Cfg Displays the virtual emulation keyboard.

Off Hides the virtual keyboard.

Arrow Keys Moves the web page up and down or from side to 
side.



Chapter 4: Developing Web Pages for the Industrial Browser 23
Chapter 4: Developing Web Pages for the 
Industrial Browser

This chapter provides information about the META tags and IDA commands 
supported by the Telnet Client Industrial Browser. You can use these tags to 
develop custom web pages that enable specific functionality in the Industrial 
Browser. The following sections are included:

• META Tags

• IDA Commands

META Tags

META tags are included at the top of a web page between the <HEAD> and  
</HEAD> tags. They are evaluated in the order they appear in the web page 
(from top to bottom). The Industrial Browser is designed to work only with 
tags it recognizes; it will ignore tags it does not recognize. If a META tag starts 
with the iBrowse_ prefix, that prefix will be ignored. For example, 
iBrowse_ScannerNavigate is the same as ScannerNavigate.

Each META tag has the following format:

<meta http-equiv=”action_name” content=”action_type”>

In the preceding format, the action_type can be a URL, an IDA action, or 
a JavaScript function. Some actions allow the action type to include 
replacement values; a ‘%s’ or ‘%d’ or ‘%ld’ string can be used to 
indicate where each replacement item belongs. 

NOTE These strings are interchangeable and can be used in any format that 
you prefer.

You can also use META tags in conjunction with a “wls:” type to launch 
Telnet scripts from a web page. For more information, refer to Wavelink Telnet 
Client Scripting Reference Guide.

The following are META tags supported by the Telnet Client Industrial 
Browser:

• BatteryNavigate
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• OnAllKeys, OnKey..., OnKey0x...

• OnStartup, IDA

• PowerOn

• Printing

• Scanner

• ScannerNavigate, ScannerProcessed

• SignalNavigate

• SpeechFromText

• SpeechSetting

• TextFromSpeech

• Symbologies

BatteryNavigate

The BatteryNavigate META tag is used to handle changes in the battery 
strength or the AC line status. The action occurs when the battery strength 
changes or when the device is plugged in or unplugged.

The four main arguments (from left to right) are: the AC line status, the 
strength of the main battery from zero to 100, the strength of the backup 
battery from zero to 100, and the main battery chemistry. A battery strength of 
255 means “unknown”.

The following are the AC line status values:

The following are the battery chemistry values:

#define AC_LINE_OFFLINE 00
#define AC_LINE_ONLINE 01
#define AC_LINE_BACKUP_POWER 02
#define AC_LINE_UNKNOWN 255

BATTERY_CHEMISTRY_ALKALINE 01
BATTERY_CHEMISTRY_NICD 02
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OnAllKeys, OnKey..., OnKey0x...

The OnKey... and OnKey0x... META tags describe an action that will 
occur if a particular key is pressed. The key values that are evaluated are the 
same key values used by Keyboard Creator. 

The OnKey0x format requires a hexadecimal number, while the OnKey 
format will require a decimal format. The key value is also case sensitive.

For example: 

OnKey50 and OnKey0x32 will both respond to the 2 key. 

OnKey65 and OnKey97 would be used to respond to both the upper and 
lowercase A.

The OnAllKeys tag will perform the prescribed action each time a key is 
pressed. The action type can include one argument, which is the string 
representing the decimal value of the key.

NOTE  Due to browser limitations, some keys (such as Tab) may not always 
be handled by this tag.

OnStartup, IDA

The OnStartup and IDA META tags allow you to specify actions that will 
be taken when the web page is first loaded. The action type must be one of the 
action types described in  IDA Commands on page 31.

PowerOn

The PowerOn META tag is used when the device turns on.

BATTERY_CHEMISTRY_NIMH 03
BATTERY_CHEMISTRY_LION 04
BATTERY_CHEMISTRY_LIPOLY 05
BATTERY_CHEMISTRY_ZINCAIR 06
BATTERY_CHEMISTRY_UNKNOWN 255
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Printing

You can send data to the printer by including the data in the META tags. Use 
the Print_Continue and Print_Finish action names to specify the 
print data. The print data is in the action type of these META tags. The print 
data in each META tag should all be on the same line and should not be more 
than 1024 characters in length; however the total print data can be larger than 
1024 characters. In addition to standard characters, you can use the following:

• \r to specify a return character

• \n to specify a newline character

• \t to specify a tab character

• \\ to specify a backslash character

• \## or \x## to specify any other character, where ## is replaced 
with a two-digit hexadecimal number

Print_Continue should be used for all but the last section of print data, 
and Print_Finish should be used for the last section of print data. 

NOTE If desired, the action names Print_Done, Print_Final, 
PLSeriesLabel_Print and ZebraLabel_Print can be used instead of 
Print_Finish.

The META tag Print_Callback can be used to specify the action that will 
occur after the printing is completed. The argument will be 0 if the printing 
was successful, or a non-zero number if the printing failed.

NOTE If desired, the action names Print_Complete, 
ZebraLabel_Complete and PLSeriesLabel_Complete can be used 
instead of Print_Callback.

The META tag Print_Setup_TP can be used to specify the IP Address and 
port of the printer if using TCP printing. If this tag is used, it must be 
specified before the Print_Finish tag. The format is address:port.

For example:
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<meta http-equiv=”Print_Setup_TP” 
content=”192.168.1.59:7429”>

<meta http-equiv=”Print_Continue”  
content=”\22First Line\22\r\n”>

<meta http-equiv=”Print_Continue” 
content=”\22Middle\22\r\n”>

<meta http-equiv=”Print_Finish”  
content=”\22Last Line\22\r\n”>

<meta http-equiv=”Print_Callback” 
content=”printresult.htm&status=%s”

Scanner

If the action name is Scanner and the action type is Enable or Resume, 
the scanner will be enabled when the page is first loaded. If the action type is 
Disable or Suspend, the scanner will be disabled when the page is first 
loaded.

There are four additional scanner action types supported by Telnet Industrial 
Browser:

• AutoTab

• AutoEnter

• AutoEnterAndTab

• NoAuto

The AutoTab, AutoEnter, and AutoEnterAndTab action types will 
enable the scanner and will cause the scan data to be followed by an enter or 
tab key (or both). The NoAuto action type will enable the scanner and will 
clear the scanner key value (if a value is specified by the emulation 
parameters).

Once enabled or disabled, the scanner will stay in that state until some other 
action (such as a META tag or IDA action) changes the state or until the user 
changes sessions.
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You can also use WEB Default Scanner Auto Keys and WEB Default Scanner 
State emulation parameters to configure the default scanner action on web 
pages with no applicable META tags. For more information on emulation 
parameters, see  Configuring WEB Emulation Parameters on page 14.

ScannerNavigate, ScannerProcessed

The ScannerNavigate META tag is used to handle raw scan data. The 
ScannerProcessed tag is similar, but gives the scan data after it has been 
modified by the scan handlers, etc. in the Emulation Parameters.

If the action type has zero to three arguments, then the arguments are (from 
left to right): the barcode data, the symbology type, and the time stamp.

If the action type has four or five arguments, then the arguments are (from 
left to right): the barcode data, source scanner name, symbology type, time 
stamp, and barcode length.

NOTE Refer to the following section for supported symbology types. 

SignalNavigate

The SignalNavigate META tag is used to handle changes in the signal 
strength of the wireless network connection. The action occurs when the 
signal strength changes or when the device disconnects from the wireless 
network.

The three arguments (from left to right) are: signal strength, connected ESSID, 
and device MAC address. The signal strength is zero to 100. Strength -1 
means “unknown.” Strength -2 means “disconnected from the wireless 
network.” ESSID and MAC addresses may be “<unknown>.” (Available on 
Windows-CE devices only.)

SpeechFromText

The SpeechFromText META tag plays the string specified by the 
“content” flag.

For example:

<meta http-equiv=”SpeechFromText” content=”I will speak 
this sentence.”>
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SpeechSetting

The SpeechSetting META tag changes one or more speech values.

For example:

The following META tag will change the Text-to-Speech settings for language 
and voice: 
<meta http-equiv=”SpeechSetting” 
content=”tts_language=American English, tts_voice=Tom”>

TextFromSpeech

The TextFromSpeech META tag will play the string specified by the 
“content” flag. This META tag function is identical to the SpeechFromText 
META tag.

Symbologies

You can enable and disable different symbologies by using the symbology as 
the action name, and Enabled or Disabled as the action type. The 
symbologies supported by Telnet Client Industrial Browser are as follows:

AUSTRALIA_POSTAL CUECODE PLANET
AZTEC D2OF1ATA PLESSY
AZTECMESA D2OF5 POSICODE
BOOKLAND DATAMATRIX POSTNET
BRITISH_POSTAL DUTCH_POSTAL QRCODE
CANADA_POSTAL EAN8 RSS14
CHINA_POSTAL EAN13 RSSEXPANDED
CODABAR I2OF5 RSSLIMITED
CODABLOCK JAPAN_POSTAL SIGNATURE
CODE11 KOREA_POSTAL TELEPEN
CODE16K MACROPDF TLC39
CODE32 MACROMICROPDF TRIOPTIC39
CODE39 MAXICODE UCC128
CODE49 MATRIX2OF5 UPCA
CODE93 MICROPDF UPCE
CODE128 MSI UPCE0
COMPOSITE OCR UPCE1
COUPONCODE PDF417 WEBCODE
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In addition to the preceding symbologies, the value ALL_DECODERS can be 
used to enable or disable all the symbologies.

For example:

To enable only UPCA, use the META tags in this order

<meta http-equiv=”ALL_DECODERS” content=”Disabled”>

<meta http-equiv=”UPCA” content=”Enabled”>

The prefix Scanner_ can also be used with all symbologies.

Element-Specific Actions

The following META tag options are also supported for individual elements:

• OnAllKeys, OnKey..., OnKey0x...

• Scanner

• Symbologies

The options can be specified in the tag that creates the element on the web 
page. If the element is selected (active), then the option will be applied. When 
the tag is not selected (inactive), then the settings will revert back to those 
specified by the META tags for the web page.

Unlike the META tags, where “http-equiv” is used to specify the action 
name and “content” is used to specify the action type, a simple 
action_name=”action type” format is used. 

For example:

The following tag will cause the Scanner to be enabled when the tag is 
selected on the web page.

<input name=”item1” id=”item1” type=”text” 
Scanner=”Enable”>

The following tag will enable the scanner only while the tag is selected. The 
scanner will be disabled otherwise.

<meta http-equiv=”Scanner” content=”Disable”>
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NOTE You can use the META tag OnStartup with an action of 
IDA_SCAN_ENABLE or IDA_SCAN_DISABLE to change the scanner state 
only when the page is first loaded.

To use element-specific Symbologies, you can either use the Symbology name 
or prefix the Symbology name with the string “Scanner_”.

For example:

The following tag will enable the scanner, AutoTab after an item is scanned, 
and turn off all Symbologies except Code128. 

<textarea name=”item2” Scanner=AutoTab 
Scanner_All_Decoders=Disable Scanner_Code128=Enable>

The Code128 enable item must come after the All_Decoders  item or it 
will be disabled when the All_Decoders item is processed.

IDA Commands

IDA commands are special values used to invoke a device action, program 
action, or emulator action within the Telnet Industrial Browser. These values 
can be specified in many of the special META tags described above, as URLs 
for the user to click on, or called inside JavaScript functions.

For example:

 <a href=”ida:IDA_SESSION_DISCONNECT”> 
Close the session</a>

-Or-

<script language=javascript> 
function OnError( ) 
{ 
     // Disconnect the Session 
     location.href = “ida:IDA_SESSION_DISCONNECT” ;

     // Alternate Method 
     document.location = “ida:IDA_SESSION_DISCONNECT” ;
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     // Another Alternate Method 
     window.navigate ( “ida:IDA_SESSION_DISCONNECT” ) ; 
} 
</script>

NOTE It is recommended that each IDA command be preceded by the ida 
prefix; however, the command will generally work without the prefix.

The following are IDA commands supported by the Telnet Industrial 
Browser:

• IDA_COLDBOOT

• IDA_COLDBOOT_PROMPT

• IDA_KEYBOARD_WEB, IDA_KEYBOARD_SHOW, or IDA_KEYBOARD_UP

• IDA_KEYBOARD_NUM or IDA_KEYBOARD_NUMERIC

• IDA_KEYBOARD_NONE, IDA_KEYBOARD_HIDE, or 
IDA_KEYBOARD_DOWN

• IDA_PROGRAM_EXIT

• IDA_PROGRAM_EXIT_PROMPT

• IDA_REPRINT

• IDA_SCAN_DISABLE or IDA_SCAN_SUSPEND

• IDA_SCAN_ENABLE or IDA_SCAN_RESUME

• IDA_SCAN_FORWARD

• IDA_SESSION_S1, IDA_SESSION_S2, IDA_SESSION_S3, 
IDA_SESSION_S4

• IDA_SESSION_DISCONNECT

• IDA_SESSION_DISCONNECT_PROMPT

• IDA_SESSION_NEXT
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• IDA_SESSION_PREVIOUS

• IDA_SIP_SHOW or IDA_SIP_UP

• IDA_SIP_HIDE or IDA_SIP_DOWN

• IDA_SIP_TOGGLE or IDA_SIP_TOGGLEHIDE

• IDA_SUSPEND or IDA_SUSPEND_DEVICE

• IDA_SUSPEND_PROMPT

• IDA_URL_BACK or IDA_BACK

• IDA_URL_BACK or IDA_BACK

• IDA_URL_BACK_DISABLE or IDA_BACK_DISABLE

• IDA_URL_BACK_ENABLE or IDA_BACK_ENABLE

• IDA_URL_FORWARD or IDA_FORWARD

• IDA_URL_FORWARD_DISABLE or IDA_FORWARD_DISABLE

• IDA_URL_FORWARD_ENABLE or IDA_FORWARD_ENABLE

• IDA_URL_HOME or IDA_HOME

• IDA_URL_HOME_DISABLE or IDA_HOME_DISABLE

• IDA_URL_HOME_ENABLE or IDA_HOME_ENABLE

• IDA_URL_REFRESH or IDA_REFRESH

• IDA_URL_STOP or IDA_STOP

• IDA_WARMBOOT

• IDA_WARMBOOT_PROMPT

• IDA_ZOOM_DISABLE or IDA_FONT_DISABLE

• IDA_ZOOM_ENABLE or IDA_FONT_ENABLE
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• IDA_ZOOM_LARGER or IDA_FONT_LARGER

• IDA_ZOOM_LARGEST or IDA_FONT_LARGEST

• IDA_ZOOM_MEDIUM or IDA_FONT_MEDIUM

• IDA_ZOOM_MINUS or IDA_FONT_MINUS

• IDA_ZOOM_PLUS or IDA_FONT_PLUS

• IDA_ZOOM_SMALLER or IDA_FONT_SMALLER

• IDA_ZOOM_SMALLEST or IDA_FONT_SMALLEST

IDA_COLDBOOT

This command causes the device to perform a cold boot.

IDA_COLDBOOT_PROMPT

This command gives the user the option to perform a cold boot or cancel the 
action.

IDA_KEYBOARD_WEB, IDA_KEYBOARD_SHOW, or                
IDA_KEYBOARD_UP

These commands cause the emulation on-screen keyboard to be displayed.

IDA_KEYBOARD_NUM or IDA_KEYBOARD_NUMERIC

These commands cause the numeric on-screen keyboard to be displayed.

IDA_KEYBOARD_NONE, IDA_KEYBOARD_HIDE, or 
IDA_KEYBOARD_DOWN

These commands cause the emulation and numeric on-screen keyboards to be 
hidden.

IDA_PROGRAM_EXIT

This command causes the device to exit the current program.
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IDA_PROGRAM_EXIT_PROMPT

This command gives the user the option to exit the program or cancel the 
action.

IDA_REPRINT

This command causes the last data supplied to the printer to be sent again. 
The print data will remain available until something else is printed or until 
the session is disconnected.

IDA_SESSION_S1, IDA_SESSION_S2, IDA_SESSION_S3, 
IDA_SESSION_S4

These commands cause the device to switch to the specified session.

IDA_SCAN_DISABLE or IDA_SCAN_SUSPEND

These commands disable the bar code scanner. When the bar code scanner is 
disabled, pressing the mobile device trigger will have no effect.

IDA_SCAN_ENABLE or IDA_SCAN_RESUME

These commands enable the bar code scanner. The bar code scanner will not 
scan for bar codes unless the mobile device trigger is pulled.

NOTE You can use the META tag OnStartup with an action of 
IDA_SCAN_ENABLE or IDA_SCAN_DISABLE to change the scanner state 
only when the page is first loaded.

IDA_SCAN_FORWARD

This command disables the barcode scanner and processes a trigger press as a 
key press. This command only functions on scanners that support trigger-
press forwarding; on all other scanners, the command performs the same 
action as IDA_SCAN_DISABLE.

IDA_SESSION_DISCONNECT

This command disconnects the session and closes the Industrial Browser.



36 Wavelink Telnet Client Industrial Browser Reference Guide
IDA_SESSION_DISCONNECT_PROMPT

This command gives the user the option to disconnect the session and close 
the Industrial Browser, or cancel the action.

IDA_SESSION_NEXT

This command opens a new session.

IDA_SESSION_PREVIOUS

This command causes the device to return to the previous session.

IDA_SIP_SHOW or IDA_SIP_UP

These commands cause the SIP on-screen keyboard to become visible.

IDA_SIP_HIDE or IDA_SIP_DOWN

These commands cause the SIP on-screen keyboard to become hidden.

IDA_SIP_TOGGLE or IDA_SIP_TOGGLEHIDE

These commands will cause the SIP on-screen keyboard to become visible if it 
is hidden, or hidden if it is visible.

IDA_SUSPEND or IDA_SUSPEND_DEVICE

These commands cause the device to suspend itself.

NOTE For CE devices, this is similar to pressing the power button.

IDA_SUSPEND_PROMPT

This command gives the user the option to suspend the device or cancel the 
action.

IDA_URL_BACK or IDA_BACK

These commands cause the Industrial Browser to display the screen previous 
to the current screen. If there are no previous screens, no action will be taken.
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IDA_URL_BACK_DISABLE or IDA_BACK_DISABLE

These commands disable the Back menu option so it cannot be selected by the 
user. 

NOTE The IDA_URL_BACK or IDA_BACK commands are not affected and 
will still work.

IDA_URL_BACK_ENABLE or IDA_BACK_ENABLE

These commands enable the Back menu option so it can be selected by the 
user. The menu option could still be disabled if there is no page to go back to.

IDA_URL_FORWARD or IDA_FORWARD

These commands cause the Industrial Browser to display the screen that was 
being displayed before the last Back command. If there was no previous 
screen, no action will be taken.

IDA_URL_FORWARD_DISABLE or IDA_FORWARD_DISABLE

These commands disable the Forward menu option so it cannot be selected by 
the user.

NOTE The IDA_URL_FORWARD or IDA_FORWARD commands are not 
affected and will still work.

IDA_URL_FORWARD_ENABLE or IDA_FORWARD_ENABLE

These commands enable the Forward menu option so it can be selected by the 
user.

NOTE The menu option could still be disabled if there is no page to return to.

IDA_URL_HOME or IDA_HOME

These commands cause the Industrial Browser to proceed to the location 
specified by the current Host Profile. It is completely independent from the
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location for any other web browsers on the device.

IDA_URL_HOME_DISABLE or IDA_HOME_DISABLE

These commands disable the Home menu option so it cannot be selected by 
the user. 

NOTE The IDA_URL_HOME or IDA_HOME commands are not affected and 
will still work.

IDA_URL_HOME_ENABLE or IDA_HOME_ENABLE

These commands enable the Home menu option so it can be selected by the 
user.

IDA_URL_REFRESH or IDA_REFRESH

These commands cause the web page to be reloaded. The server will be 
queried to verify that the page contents are up-to-date.

IDA_URL_STOP or IDA_STOP

These commands cause the web page to stop loading. If the web page is 
already fully loaded, this action has no effect.

IDA_WARMBOOT

This command causes the device to perform a warm boot.

IDA_WARMBOOT_PROMPT

This command gives the user the option to perform a warm boot or cancel the 
action.

IDA_ZOOM_DISABLE or IDA_FONT_DISABLE

These commands disable the Text Size menu so it cannot be selected by the 
user. 

NOTE The IDA options to set the zoom level (text size) are not affected and 
will still work.
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IDA_ZOOM_ENABLE or IDA_FONT_ENABLE

These commands enable the Text Size menu so it can be selected by the user.

IDA_ZOOM_LARGER or IDA_FONT_LARGER

These commands cause the Industrial Browser to display the text using a 
large text size. 

NOTE This is a global setting. Other Telnet sessions, Internet Explorer, and 
Pocket Internet Explorer will default to using this text size as well.

IDA_ZOOM_LARGEST or IDA_FONT_LARGEST

These commands cause the Industrial Browser to display the text using the 
largest text size supported by the browser. 

NOTE This is a global setting. Other Telnet sessions, Internet Explorer, and 
Pocket Internet Explorer will default to using this text size as well.

IDA_ZOOM_MEDIUM or IDA_FONT_MEDIUM

These commands cause the Industrial Browser to display the text using a 
medium text size. 

NOTE This is a global setting. Other Telnet sessions, Internet Explorer, and 
Pocket Internet Explorer will default to using this text size as well.

IDA_ZOOM_MINUS or IDA_FONT_MINUS

These commands cause the Industrial Browser to display the text using the 
next-smaller text size than the current text size.

NOTE This is a global setting. Other Telnet sessions, Internet Explorer, and 
Pocket Internet Explorer will default to using this text size as well.



40 Wavelink Telnet Client Industrial Browser Reference Guide
IDA_ZOOM_PLUS or IDA_FONT_PLUS

These commands cause the Industrial Browser to display the text using the 
next-larger text size than the current text size.

NOTE This is a global setting. Other Telnet sessions, Internet Explorer, and 
Pocket Internet Explorer will default to using this text size as well.

IDA_ZOOM_SMALLER or IDA_FONT_SMALLER

These commands cause the Industrial Browser to display the text using a 
small text size. 

NOTE This is a global setting. Other Telnet sessions, Internet Explorer, and 
Pocket Internet Explorer will default to using this text size as well.

IDA_ZOOM_SMALLEST or IDA_FONT_SMALLEST

These commands cause the Industrial Browser to display the text using the 
smallest text size supported by the browser. 

NOTE This is a global setting. Other Telnet sessions, Internet Explorer, and 
Pocket Internet Explorer will default to using this text size as well.
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Appendix A: Wavelink Contact Information
If you have comments or questions regarding this product, please contact 
Wavelink Customer Service.

E-mail Wavelink Customer Support at: CustomerService@wavelink.com

For customers within North America and Canada, call the Wavelink Technical 
Support line at 801-316-9000 (option 2) or 888-699-9283.

For international customers, call the international Wavelink Technical 
Support line at +800 9283 5465.

For Europe, Middle East, and Africa, hours are 9 AM - 5 PM GMT. 

For all other customers, hours are 7 AM - 7 PM MST.
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